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The beginning
In our profession, it’s up there with death and taxes:
the inescapability of Microsoft Word. It’s
everywhere—and everywhere, every hour, someone
joins the legions of those who have come to loathe its
idiosyncrasies and its instability. In this issue, Geoff
Hart, Fellow of the Society for Technical
Communication, assures us that all hope need not be
abandoned—so long as we take some simple
precautions to protect ourselves from the oftentimes
fathomless behaviour of MS Word.
Many of us have had the pleasure of using Adobe
FrameMaker to author our technical documents, a
product whose stability and robustness provides the
starkest contrast with MS Word. But this tool has its
own flaws, one of which is the inconvenient default
size of some of its dialog boxes. Beginning on page 5,
Dave Reynolds explains how you can resize dialog
boxes and the fields on them.
For centuries, the paragraph has been an essential
building block in written text. Alas, some
contemporary practices—such as the omission of the
first‐line indent and the growing fondness for one‐
sentence paragraphs—is robbing writing of
usability. See page 9 for reasons why these practices
should be re‐assessed—and abandoned.
DITA continues to be of great interest to technical
writers. Beginning on page 15, Suchitra
Govindarajan explains that you don’t need a lot of
under‐the‐bonnet knowledge about DITA to start
topic‐based authoring according to the DITA
standard.
Our immense gratitude is owed to internationally
renowned cartoonist Michael Leunig for his
permission to reprint a cartoon depicting possibly
the most worrying trend in modern digital
communication. See page 13. Cactus, indeed.
Finally, if you’re a budding poet and have something
interesting, novel or whacky to say about technical
writing, you might be interested in contributing to
the next issue of Words. See page 20 for details.
Geoffrey Marnell
Editor [geoffrey@abelard.com.au]
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Protecting yourself from
Microsoft Word …

… with a few relevant notes for other
programs
Geoff Hart
If you’ve used Microsoft Word for any length of
time, you know that crashes and loss of work are a
fact of life. Word has become much better over time,
but it remains unstable and annoying to work with,
particularly the Macintosh versions. But despite its
many flaws, there are ways to protect yourself, and
they fall into two main categories:


perform preventative maintenance



develop recovery strategies.

In this brief article, I’ll explain some of the things
you need to know to protect yourself. Although my
focus is on Word 2003 and previous versions, many
of the tips in this article work equally well for other
word processors (mutatis mutandis) and other
versions of Word, with appropriate modifications.
Before continuing, you need to know where to go
to change certain key settings in Word:


In Windows: Tools > Options



Macintosh OS X: Word > Preferences. For other
word processors, open the menu that has the
same name as the program, and select
Preferences.

Words is published by Abelard Consulting, a documentation consultancy providing technical writing services, technical writer placement services, and
training in technical, scientific and business writing. Visit www.abelard.com.au, email info@abelard.com.au or call 1800 601 116 for further information.

Perform preventative
maintenance

To find orphaned work files that aren’t in your
current working directory, close Word, then search
your hard disk using the operating system’s search
tool (under the Windows menu, or by pressing
COMMAND + F in any Finder window on the Macintosh).
Search for files with “Word work” in the file name,
files whose name begins with the tilde character (~),
or files whose name ends in .tmp. Depending on
which operating system and which version of Word
you’re using, you may need to set the options for the
search function to find “invisible” files.

Preventative maintenance involves taking steps to
prevent problems from occurring in the first place.
The importance of these steps varies among versions
of Word, with the steps being most necessary for
older versions.
The first group of strategies involves simple
housekeeping. Like most software, Word creates
temporary files that it uses behind the scenes while
you work. Unlike most software, Word did a
generally poor job of cleaning up after itself until
fairly recently in its history, making the “temporary”
part of the name a notorious oxymoron.

To find autorecover files, search for files that
contain the words “autorecovery save of” in their
name. Unless Word has recently crashed and you
need to recover data from any of these files, simply
delete them. Add a reminder to your calendar to
The two most problematic types of temporary file
search for these files at least monthly until you learn
are work files and autorecover files. Work files, which
whether they’re accumulating on your system; if not,
have names that end in .tmp or
you can delete this reminder,
that include the words “Word
but if they are accumulating,
work” in the file name, used to
finding and deleting them
Key strategies
accumulate in older versions
should become part of your
of Word. The files never got
monthly maintenance routine.
 monitor temporary files
deleted on some computers,
 avoid unreliable features
The second group of
and when Word could no
minimise
version
conversion

strategies
involves avoiding
longer deal with all these files,
problematic
features that have
it would gradually become
never
worked
reliably for most
unstable, leading to crashes
users.
(Note
that
although
these
features
work just
and loss of information. Autorecover files are files
fine
for
some
users,
at
least
for
short
periods,
they
that Word creates to let you recover as much work as
tend
to
fail
unpredictably
for
reasons
nobody
seems
possible in the event of a crash. When Word shuts
to
explain.
In
my
books,
that
makes
them
able
down normally, rather than crashing, it erases the
unreliable.) These include the Fast Save function,
autorecover files as part of its shutdown routine. But
which
you can disable in the Save tab of the Options
when Word crashes, these files are left behind.
or
Preferences
dialog box. Similarly, avoid using the
Autorecover files are less problematic than the
Versions
feature
(under the File menu), since it seems
temporary work files, but can still cause problems if
to
have
been
implemented
using the same
they accumulate.
programming code as Fast Save. The Master
The solution to instability related to the
Documents feature should also be avoided, since it
accumulation of temporary files is to learn where
has been a frequent cause of corrupted files ever since
these files are stored, and check whether they are
it was introduced, and I have no evidence this feature
accumulating in sufficient quantities to pose a
has been fixed as of Word 2007. Finally, never embed
problem. In more recent versions of Word, the work
a table in a cell of another table. Such nested tables
files appear in the same directory as the document
rapidly become unstable, and can lead to crashes and
you’re working on. The autorecover files appear in a
lost data. If you need to divide a cell of a table into
specific directory, and you can learn its location (and
sub‐cells, it’s safer to open the Table menu and select
change that location) in this way:
Split Cells. Specify the number of rows and columns,
click OK, and continue working.
1. Select Tools > Options (Windows) or Word >
Preferences (Macintosh).

The third group of strategies relates to
incompatibilities between versions of Word.
Wherever possible, you should avoid repeatedly
transferring files between versions of Word, and
between versions of Word on different operating
systems (for example, Macintosh versus Windows
versions, North American versus Asian versions).
Such transfers generally work well, with only minor
incompatibilities, but any transfer that requires
conversion of a document into a slightly different
version of the .doc (Word 2003 and earlier) or .docx
(Word 2007) file format increases your risks. I
maintain four versions of Word on my computer

2. Select the File Locations tab.
3. In the File types list, click AutoRecover files.
4. Click the Modify button.
You can now use the standard Windows or
Macintosh dialog box navigation features to learn
the path to the current directory, to choose a new
path, or even to create a new directory (perhaps
one with a memorable name such as “Word
autorecover files” that will make it easy to find
these files in future).
2.1 ~ 2010
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(Word X and 2008 for Macintosh, and Word 2003 and
2007 for Windows) to minimise this problem, but I’m
an extreme case because I transfer files between
many versions of Word on many operating systems.
For most people, standardising on a single version of
Word is the easiest solution.

The second option in the Save tab is Always
create backup copy (see Figure 1 above). Using this
feature, Word creates a file named “Backup copy of
[the name of your file]” each time you open a file.
Should Word crash, or should you spend an hour
working on the file and decide you prefer the
original, you can simply close the open file and start
working again from the backup copy. Although this
is a useful feature, I’ve found that it’s wiser to create
your own backup copies. To do so, open a folder on
your desktop that contains the document you’re
working on, and periodically make a copy (right‐
click the file and select Make a copy in Windows;
select the file and press COMMAND + D on the Macintosh).
Then copy it to a flash drive or e‐mail yourself a copy.
This can be tedious if you work on a file for long
periods of time, but it places full control of backing
up the files in your hands instead of relying on Word.

Develop recovery strategies
Word offers two built‐in protections. These can be set
in the Save tab of the Options or Preferences dialog
box (see Figure 1 below). The Save AutoRecover info
every [x minutes] option lets you define the interval
at which Word will save an autorecover file. If Word
crashes, this file lets you recover some of the
information that you typed since the last time you
saved the file manually. On most computers and
with most versions of Word, setting the interval to 10
minutes is sufficient if you’re paranoid, and setting
the interval to 30 minutes will be fine for most users.
With these settings, Word will save autorecovery
information every 10 or 30 minutes, respectively; if it
crashes, you’ll only lose the information you typed
since the last save of the autorecovery file (a
maximum of 10 or 30 minutes, respectively, of
typing). If your copy of Word is particularly crash‐
prone, train yourself to manually save the file
(CONTROL+ S in Windows and COMMAND + S on the Mac)
fairly frequently. Choosing to create the
autorecovery files frequently seems like a logical
step, but if the interval is too short and you work too
long on the file, older versions of Word may run into
problems with having to juggle too many files
simultaneously and may crash.

When a Word file becomes corrupt, it may
become impossible to open it, or you may be able to
open it, but find that it crashes Word. If a file is not
this badly damaged, but shows signs of growing
corruption—such as unusually long times to open or
save the file, frequent crashes, or incorrect behaviour
when you modify or update styles—consider trying
this trick, first introduced by Woody Leonard in his
classic book Word 97 Annoyances:
1. Place the cursor at the end of the file, just before
the final paragraph marker.
If you can’t see that marker, open the Options or
Preferences dialog box and select the Paragraph
marks checkbox in the View tab.
2. Press CONTROL + SHIFT + HOME (Windows) or
COMMAND + SHIFT + HOME (Macintosh) to select all of
the document except the final paragraph marker.
3. Copy the selected text.
4. Open a new document and paste the copied text
into it.
This trick became so useful to editors that in the
copyediting‐l discussion group, it became known as
“maggying” a file (after Maggie Secara, who
popularised the technique).
If this trick doesn’t work, you can try inserting the
file into a new document:
1. Create a new document.
2. Select File > Insert and select the problem file.
3. When Word has finished inserting it, save the file
under a new name.
When file corruption grows too much for these
tricks to work, a new feature introduced in Word
2003 for Windows (but not, so far as I can tell, in
Word 2008 for the Macintosh) can help:

Figure 1: Recovery strategies

1. Close the problem file and make a duplicate copy,
in case you need to return to that copy.

Words
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2. Select File > Open. In the
Open or Open File dialog
box, select the problem
file, but do not click OK.
Instead, look for the small
drop‐down menu beside
the Open button—it
usually looks like a
downward‐pointing
arrow: see Figure 2—and
open that menu instead.

3. From the drop‐down menu, select Open and
Repair.
This new feature will fix many of the most
common problems that occur in Word
documents.
4. If you can successfully open and repair the file in
this manner, save a copy under a new name and
work with that copy henceforth.

Figure 2: Open menu

If this fails, you can sometimes open a file in other
software such as OpenOffice Writer or Adobe
InDesign. Both have occasionally saved my ASCII.

Trust, but not too far
I don’t want to make you paranoid with this article.
Word is generally a robust, stable word processor,
and I spend eight or more hours working safely with
it on a typical work day. That’s particularly true since
I switched to Word 2003, and Word 2007 is said to be
even more stable. If you don’t push Word quite as
hard as I do, you won’t often encounter grave
problems. But if you do push it hard, or if you do
encounter problems, the tips in this article should
reduce the frequency of problems and help you
recover all or most of your work should a problem
arise.

Eﬀective Onscreen Editing: new
tools for an old profession
Editors are increasingly being asked to
edit on the screen using a word processor, but most are ﬁnding it challenging
to transfer their skills to editing with a
word processor. Eﬀective Onscreen Editing
teaches the basics you need to learn to
make the transition, plus proven tips and
tricks to maximise your productivity and
eﬀectiveness. The book describes general
principles valid for any software, then
illustrates the principles using Microsoft
Word to make them more concrete.

Whether or not Word is giving you problems, be
sure to make frequent backups, and store them
somewhere safe. It’s been said that there are only two
types of computer users: those who have lost hours of
their work, and those who soon will. My experience
mentoring other writers and editors tells me this is
truer than most people are willing to believe until
they find themselves in the first category.

Available as a printed book or as an
eBook optimised for onscreen reading.
Learn more at the book’s Web page:
http://www.geoﬀ-hart.com/books/
eoe/onscreen-book.htm

Geoff Hart
Geoff Hart is a scientific editor who specialises in working
with authors for whom English is a second or third
language. He is also the author of Effective Onscreen Editing
(http://www.geoff-hart.com/books/eoe/onscreenbook.htm). Geoff also works as a French translator and
occasionally as a technical writer. In his spare time, he
commits bloggery (http://blatherskite.dreamwidth.org/).
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Customising FrameMaker dialog boxes
Dave Reynolds
This tutorial explains how to customise FrameMaker
dialog boxes to suit your particular requirements.
This can be done using a program called Resource
Hacker™ to edit the file that controls the appearance
of each FrameMaker dialog box: fmdlg.dll.
The particular customisation described in this
tutorial modifies the standard Cross‐Reference
dialog box so that it can display more information
than it does by default. Figure 1 shows the default
Cross‐Reference dialog box and Figure 2 shows the
modified version of it. Note the expanded
Paragraphs field and the much longer list area.
The procedure outlined here can be followed for
whatever dialog box you want to modify.

Figure 2: Customised Cross-Reference dialog box

Preparation
Download Resource Hacker™

Figure 1: Default Cross-Reference dialog box

Download Angus Johnson’s Resource Hacker
program. One of a number of download sites is:

Constraints

http://www.angusj.com/resourcehacker/

I used modified dialog boxes in FrameMaker 6 for
many years and found only one problem: when I
opened a file with missing referenced graphics and
chose to skip the missing files, FrameMaker crashed.
To open a file with missing graphics, I had to revert
to the original fmdlg.dll file.

You don’t need to install the program. Just extract
the files from the downloaded zip file to a suitable
folder on your local drive.

Locate and copy fmdlg.dll

I have used modified dialog boxes in FrameMaker
8 for a few years now without problems. There is no
problem opening files with missing referenced
graphics. However, I did find when testing
FrameMaker 8 that I could not always use the
modified FrameMaker 6 fmdlg.dll file.
FrameMaker 8 appeared to work normally with the
FrameMaker 6 file until I tried to update a book: and
then it crashed. I had to modify the FrameMaker 8
fmdlg.dll file to work with books.

The file you need to modify is in the fminit folder
inside your FrameMaker program folder. The default
path to the fminit folder in FrameMaker 8 is:
C:\Program Files\Adobe\
FrameMaker8\fminit

1. Navigate to the fminit folder and locate
fmdlg.dll.
2. Make a copy of fmdlg.dll and give it an easily
recognisable name, such as fmdlg.dll.orig.

I have not tested modified dialog boxes in
FrameMaker 7 or 9.

Words

The copied file will enable you to revert to the
default settings if necessary.

5

2.1 ~ 2010

Dialog box screen shots

2. Click on 1033. An editable version of the Cross‐
Reference dialog box appears (see Figure 4).

You may find it useful to take a screen shot of a dialog
box you intend to modify. You can use this as a
reference when you start your modifications. (This is
especially handy if you want the modified dialog box
to resemble the original dialog box but you forget the
layout part‐way through the exercise.)
You might also find it useful to make notes about
what you’ve done so that you can more easily repeat
the process, if necessary.

Method
Run Resource Hacker
1. Double‐click ResHacker.exe, one of the files you
extracted after you downloaded Resource
Hacker.
2. Click Run.

Figure 4: Default Cross-Reference dialog box open
in Resource Hacker

3. When Resource Hacker opens, select File > Open.
4. Navigate to the fminit folder, select fmdlg.dll
and click Open.

Any changes you make to this window will be
replicated in the Cross‐Reference dialog box
when you next open FrameMaker, so be careful
what you do with this window.

5. Expand the Dialog folder in the left pane. A list
of the available dialog boxes is displayed, in
alphabetical order (see Figure 3).

The code for this dialog box is displayed in the
right pane of the main Resource Hacker window.
Any changes made to the dialog box are recorded
in this code pane. Be careful not to accidentally
change or delete any of this code.
Each element in the dialog box can be selected,
moved or resized. This includes text, buttons,
fields and borders. Once selected, an element
displays resizing handles just as in any drawing
program. A red asterisk appears beside the
corresponding line in the code pane.
3. Click and drag the bottom right corner to enlarge
the dialog box. Note how the third and fourth
“XREF_MAIN_DIALOG” coordinates at the top
of the code pane change. (The expanded dialog
box shown in Figure 2 has coordinates of 33, 49,
366, 484.) Moving any element in the dialog box
will likewise change its coordinates in the code
pane.

Figure 3: fmdlg.dll open in Resource Hacker

Edit fmdlg.dll
This tutorial explains how to modify the default
Cross‐Reference dialog box to show more
information in the Paragraph Tags and Paragraphs
fields. Expanding the Paragraphs field in width
allows it to display more of the content of target
paragraphs. This is very useful if you have many
instructions that start with similar text. We will also
expand the fields vertically to display more target
paragraphs.

4. Move the Insert, Convert to Text and Cancel
buttons to the bottom of the expanded dialog
box.
You can drag them to their new position or use the
arrow keys. The coordinates shown in the code
pane can help you align the buttons. Note that
you can only move one element at a time.
5. Move the rest of the elements under (and
including) Reference to the bottom of the dialog
box. Again, you will need to do this one element
at a time. (Resort to your screen shot if you forget
where each element belongs in relation to others.)

1. Scroll through the list of dialog names and
double‐click XREF_MAIN.
An option named 1033 appears as a sub‐item.

2.1 ~ 2010
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6. Enlarge the Paragraph Tags and Elements (in
Document Order) fields to fill the expanded
dialog box, as shown in Figure 5. (Again, the
coordinates shown in the code pane can help you
align the two fields.)

NOTE: You can’t constrain the movement of
elements—vertically or horizontally—with the
shift or control keys as you can in a standard
drawing program. If you want to move an
element exactly, select it and then move it with the
arrow keys. This is a lot slower, but more precise.
(Alternatively, exactly specify its coordinates in
the code pane.)
Note too that there is no Undo feature if you
modify the dialog box directly (by moving and
resizing its elements). The Undo feature is only
available if you modify the code directly.
7. Once you are happy with the new layout, click
Compile Script (above the code pane).
8. Select File > Save.
9. Run FrameMaker and check your new‐look
dialog box. If any further changes are needed,
close FrameMaker and continue editing the file in
Resource Hacker.

Dave Reynolds
Dave Reynolds is a senior technical author at Tait
Electronics in Christchurch, New Zealand. He has been
with the company since 1985, during which time he has
worked on numerous documents relating to the
company’s two‐way radio equipment.
In the next issue of Words, Dave explains how to customise
FrameMaker shortcuts.
Figure 5: Modified Cross-Reference dialog box open in
Resource Hacker

Technical, general & scientific writing, FrameMaker, Structured authoring
Abelard Consulting oﬀers a number of courses and workshops
designed to beneﬁt technical writers, would-be technical writers, and
those whose job requires them to be good communicators. The
following courses are available:

When?
Download a brochure or visit www.abelard.com.au/booking.html to see
dates and locations.

Technical Writing: An Introduction and Refresher [2 days]
Scientiﬁc Writing: An Introduction and Refresher [2 days]
Using Adobe FrameMaker: An Introduction and Refresher [2 days]
Structured Authoring with Adobe FrameMaker [2 days]
Business Writing: The Fundamentals of Clear Communication [2 days]

Where?
Scheduled classes are held in Melbourne, Sydney, Canberra, Perth,
Brisbane and Adelaide. Customised on-site training is also available.

What?

By whom?
The FrameMaker and structured authoring courses are conducted by
Mark Ward. Mark is a long-time user of FrameMaker and an expert in
creating FrameMaker templates and structured applications.
The writing courses are designed and conducted by Dr Geoﬀrey Marnell.
Geoﬀrey is the founder and principal consultant of Abelard Consulting.
He also teaches Technical Writing and Editing in the English Department
at the University of Melbourne and is accredited by IPEd (Institute of
Professional Editors). Geoﬀrey has more than 20 years experience as a
technical writer, documentation consultant and educator.

Discounts?

To see the topics covered in a course, download a brochure from
www.courses.abelard.com.au. We can also tailor a course to your
speciﬁc requirements. Call 1800 601 116 for further inbformation.

Early-bird, concessional and student discounts apply. Further, on-site
training is charged at a ﬂat rate regardless of the number of participants.

ABELARD
Freephone: 1800 601 116

Words

Telephone: +61 3 9596 3456
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Journals
Rhetoric, Professional Communication, and Globalization
Barry Thatcher, Kirk St. Amant

such as the environment, immigration, health,
energy, economics, and human rights

This journal publishes research articles on the theory,
practice, and teaching of professional
communication in critical global contexts such as
business, manufacturing, law, health, education,
technology, environment, and others. The journal
welcomes articles with diverse rhetorical styles,
types of inquiry, and contexts of research, but articles
are to be submitted in English and grounded in
relevant theory and appropriate empirical research
methods. The journal is peer reviewed with an
editorial board consisting of experienced researchers
and practitioners from over 20 countries.

develop better theoretical models of global
professional communication



develop a variety of valid and ethical research
methodologies for global professional
communications



improve the practice of global business and
manufacturing through more effective
communication



develop inquiries and research agendas that
address the most pressing issues and challenges
for communicating in the context of globalisation
and



develop better curricula and materials for
teaching global professional communication, not
only in the United States and Europe, but around
the world. Special attention will be given to
developing nations.

The journal will be free or open access, using PKP
open‐source software and housed at Eastern
Carolina University. The first edition is planned for
June 2010, and it will be published quarterly
thereafter. Watch for it online at www.rpcg.org. For
more information on the journal, contact Barry
Thatcher (bathatch@nmsu.edu) or Kirk St. Amant
(kirk.stamant@gmail.com).

The Journal’s main objectives are to:




Barry Thatcher
Founder/Editor‐in‐Chief, New Mexico State University

Kirk St. Amant

improve the professional communication in
critical cross‐cultural and international contexts

Assistant Editor, East Carolina University

Journal of Technical Writing and Communication
Contents of the current issue
Click the heading below to read the editorial,
abstracts and reviews, or to purchase an article or
subscribe.
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Paragraphing: a vanishing art?
Paragraph cohesion and linking
words

Geoffrey Marnell
As traditionally defined, a paragraph is a container
for one unit of thought and typically comprises two
or more related sentences. Put another way, it
expresses one main idea or point and all the
sentences in it are related to that main idea or point.1

If a paragraph is a unit of thought expressing one
main idea with all the sentences in it related to that
main idea, you need to show how the sentences—or
more appropriately the ideas in the sentences—are
related to one another. When it is clear how all the
sentences in a paragraph are related, we say that the
paragraph exhibits cohesion. The sentences stick
together, and reading them provides a fluid,
unbroken stream of ideas.

In informative writing, it is a good idea to begin
each paragraph with a topic sentence: a sentence that
introduces or summarises what the main idea or
point in the paragraph is. This is especially useful to
those readers—probably the majority of us—who
will skim or scan your text looking just for the main
ideas or points.2
Consider this example:
“There are two purposes
for paragraphs, the one
logical and the other
practical. The logical
purpose is to signal stages
in a narrative or
argument. The practical
one is to relieve the
forbidding gloom of a
solid page of text.”3

One way of ensuring a fluid, unbroken stream of
ideas is to introduce the second and each subsequent
sentence with a word or phrase that indicates the link
between it and the sentence
before it. Common linking
words or phrases are therefore,
A new paragraph needs to be indented.
so, hence, accordingly, it follows
Space alone does not always give the reader
then, as a result, in contrast, at the
an unambiguous clue that a new paragraph
same time, however, further and
has begun. Further, space can suggest that
for the same reason:
a new paragraph has begun when it hasn’t.
“A number of drugs have
shown promise in treating
the disease. Doxycycline at 250mg killed 90% of the
bacteria. In contrast, penicillin at the same dosage
killed at best 60%. However, penicillin at 500mg
killed all the bacteria. Therefore, our
recommendation …”

Note the topic sentence at the start of the paragraph.
It clearly tells us what the paragraph is about, and
each subsequent sentence is clearly related to it and
fulfils its promise.
Another good reason for starting each paragraph
with a topic sentence is that it helps crystallise your
thoughts. It also reduces the likelihood that you will
include in the paragraph other matters that may well
deserve a paragraph of their own.

A pronoun, such as it, can also usefully link one
sentence with another.
“Melanoma is a particularly aggressive form of skin
cancer. It kills 1600 Australians every year.”

Indeed, there is no circumscribed set of words or
phrases that will work as linking words. The pool
you can choose from is vast, so long as your reader
can see the development of your argument or
description—that is, see how the distinct ideas in
each of your sentences are:

Still, it is legitimate to start a paragraph in other
ways. However, with the skimming reader in mind,
it is best always to make it clear in the introductory
sentence what purpose the paragraph is serving. For
example, suppose you start a paragraph with the
sentence “An example is illustrated below”. Strictly
speaking, this is not a topic sentence, but it does
indicate to the reader that the purpose of the
paragraph is to illustrate something that was
discussed in the previous paragraph. Thus the needs
of the skimming reader are met. Another example:
“However, there are counter‐examples”. Again, this
is not, strictly speaking, a topic sentence, but it does
indicate to the skimming reader that material
discussed in the previous paragraph is about to be
contradicted.

1.
2.
3.

Words



related to the main topic that the paragraph is
about and



related to each other (through elaboration,
extension or qualification).

Paragraph styling
In traditional publishing, a paragraph is indented (or
at least every paragraph other than the first
paragraph after a heading is indented). This is the
style that has been adopted in this bulletin. However,
the widespread contemporary practice is not to
indent paragraphs, but to separate them with a blank
line (or with extra space above or below the
paragraph).

The Penguin working words: an Australian guide to modern English
usage, Penguin, Ringwood, 1993, p. 390.
Pam Peters, The Cambridge guide to Australian English usage,
Cambridge University Press, Cambridge (UK), 2007, p. 594.
Nicholas Hudson, Modern Australian usage, Oxford University
Press, Melbourne, 1993, p. 294.

The contemporary practice is flawed, and for two
main reasons. First, if a paragraph falls at the bottom
9
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of a page and its last sentence finishes close to the
right margin, there are no obvious clues for the
reader to interpret the next sentence—starting at the
top of the next page—as the beginning of a new
paragraph (if that is what it is). If you have a space
after or space before setting as part of your style
definitions, the space is ignored in both Microsoft
Word and Adobe FrameMaker. The first line of the
next block of texts starts flush against the top margin
regardless of your space settings. If you use the ENTER
key to manually add space between paragraphs—a
common though unwise practice—you will get a
blank line at the top of the next page. But how can
you expect the reader of a print‐out of the document
to interpret that space as space in addition to the normal
space above the main text frame (that is, in addition to the
height of the top margin)? Readers don’t keep in mind
the exact height of the top margin so that they can
easily detect variances, and most of us wouldn’t be
able to anyway by eye alone. Moreover, you can’t
expect the reader to look across at the facing page in
order to judge whether both top lines are level. That
is simply not how people read. Even so, it would only
provide useful information if one, but not both, top
lines represented the start of a new paragraph.

It is difficult, if not impossible, to develop a thought
or idea in just a single sentence. And if you continue
the development of that one thought or idea across a
number of paragraphs, you run the risk of
introducing ambiguity. This is partly because readers
will be expecting subsequent paragraphs to be about
another idea or thought. It is also because readers
have no immediate cues that, say, sentence six is still
talking about the topic introduced in sentence one or
is talking about a new topic altogether.
One‐sentence paragraphs are also inimical to the
skimming reader (which is most of us). Where every
paragraph is just one sentence, skim reading—the
reading of the first sentence in a paragraph—is
tantamount to reading the entire document. Faced
with a document entirely of one‐sentence
paragraphs, the busy reader is likely to abandon
reading before long.
On the other hand, long paragraphs can become
overwhelming. They might also amalgamate more
than one thought or idea, thereby denying the
skimming reader a true glimpse of the main
development or argument.
So what is an appropriate length?

The first‐line indent of traditional publishing
overcomes this problem.

“For general purposes, paragraphs from 3 to 8
sentences long are a suitable size for developing
discussion, and some publishers recommend an
upper limit of 5/6 sentences.”2

The first‐line indent overcomes another problem
inherent in the contemporary practice of using just
space to separate paragraphs. This occurs where you
have block text, that is, text set off from the main body
of the paragraph (as in the following example):

Composing a paragraph
How does one decide what should go into a
paragraph and what is best placed in another
paragraph? The common definition of a paragraph as
a unit of thought expressing one main idea with all the
sentences in it related to that main idea is a little vague,
and thus of limited practical use. We could flesh out
the definition to:

This is an example of block text, text set off from the
parent paragraph but still part of the parent
paragraph.

If space is the only guide a reader has as to when a
new paragraph begins, then it will not be obvious to
the reader when the text below a piece of block text
begins a new paragraph. Note that this particular
block of text is not indented, which should make it
clear that it is the continuation of the paragraph that
began just before the block text—but only because of
the convention adopted in this bulletin of indenting
new paragraphs (other than the first one after a
heading).

A paragraph is one sentence that expresses the
main topic to be discussed, together with other
sentences that elaborate, expand on or analyse
that main topic.
This is a stronger definition and provides some
guidance as to what should go into a paragraph, but
it still has practical limitations.

You can automate most indenting with appropriate
style definitions. Simply specify that the paragraph
style to follow each heading style is one without a left
indent (say body_full_out) and specify that the
paragraph style to follow the body_full_out style is
one with a left indent (say body_indented). Finally,
specify that the style to follow body_indented is
body_indented.

Unfortunately there is no widely accepted
formula or algorithm you can apply to determine
whether a sentence belongs in one paragraph or
another. But if we combine these definitions—with
their emphasis on a paragraph necessarily being a
container for one main idea or thought—with two
facts about how people read, we can pull out of the

Paragraph length
1.

A paragraph can have any number of sentences.
However, it’s best to avoid the one‐sentence
paragraph, increasingly common in newspapers.1
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2.
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The one‐sentence command (or step) in a procedure is a
notable exception. The practice of separating the command
from the result, and from other explanatory notes, generally
improves the efficiency with which tasks are done.
Pam Peters, op. cit., p. 595.

Words

mixture an algorithm of some practical use. The extra
two facts we need to acknowledge are:




given as much prominence as the facts to be got
across. Here is an example:
“Quasars and black holes

readers find long paragraphs uninviting, and
even daunting; they find it easier to process new
information if it is provided in chunks

“When I was growing up in the Goulburn
Valley, there were few clubs or societies for
children interested in anything other than
sport.”

readers commonly skim or scan, reading the
introductory sentence before deciding whether to
continue reading the paragraph or to skip to the
next.

In technical and scientific writing, facts always
take centre‐stage. Scene‐setting, especially of an
autobiographical nature, is not directly relevant to
the needs of the typical reader.

Bearing all this in mind, the following approach—
illustrated in figure 1 on page 12—might be useful in
many forms of declarative or informative writing
(although certainly not in novel or story writing). It
assumes that you have just written the heading of the
section you want to write about and are about to
compose the first paragraph after that heading.

3. Write another sentence.
4. Is this sentence strongly relevant to the topic
sentence?
If the sentence is not strongly relevant, move it to
another paragraph (or delete it) and then repeat
from step 3 above. If the sentence is strongly
relevant, go to step 5.

The technique
1. Write a topic sentence, that is, a sentence that
introduces or summarises what the main idea is
in the paragraph you are setting out to write.

5. Are you intending to give the sub‐topic
introduced with the new sentence in‐depth
treatment right now (more than two or three
sentences)?

2. Is the topic sentence conceptually related to the
topic suggested by the heading of the section?

If not, leave the sentence in the paragraph for now
and go to step 7; otherwise go to step 6.

If the topic sentence is not conceptually related,
delete it and start again.

6. Are you going to give other sub‐topics you intend
to add to the paragraph similar in‐depth
treatment?

This step prevents you lapsing into journalism,
where colour, context, characters and setting are

If so, move this sentence to a new paragraph and
continue from step 8. In‐depth treatment of two or
more topics is best spread across several
paragraphs rather than crammed into one long
paragraph. Remember: readers shun long
paragraphs.
7. Is the sentence crucial to the overall description,
argument or analysis being expanded in the
document (or the current section of the
document)?
If it is crucial, move it to another paragraph and
consider making it the topic sentence in that
paragraph. (Skimmers only read the first sentence
of a paragraph before moving on, and thus if your
sentence is essential in whatever description,
argument or analysis you are developing, then
ideally it should be placed at the start of a
paragraph.)
If it is not crucial, leave it where it is.
8. If you have more to write about the main topic of
the paragraph (as expressed in the topic sentence)
then continue from step 3 above. Otherwise
review the paragraph for logical sequence and
cohesion and then move on to the next
paragraph.

Words
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sentence, there will not be a significant gap in their
understanding of the ways of setting a balloon aloft. So
leave the sentence in the paragraph.]

Start

One simple way is to use household caustic soda
and aluminium scraps. [Strongly relevant to topic? Yes.
And this sub‐topic is going to get in‐depth treatment, but
no other way of creating hydrogen is going to receive in‐
depth treatment in this paragraph (otherwise this sentence
would be moved to a new paragraph). Further, the sentence
is not crucial to the overall development of the information.
So leave the sentence in the paragraph.]

Write a topic
sentence

Discard sentence

No

Is it directly relevant
to the heading or
document?

Place three or four tablespoons of caustic soda in
a glass bottle with a narrow neck. [Strongly relevant to
topic? Yes. And this sub‐topic is not going to get in‐depth
treatment nor is it crucial to overall development of the
passage. So leave the sentence in the paragraph.]

Yes

Write another
sentence

No

Will you give
the sub-topic
in-depth
treatment now?

Yes

Another way to set a balloon aloft is to fill it with
helium. [Strongly relevant to topic sentence? No, the
topic sentence is about filling a balloon with hydrogen. So
this sentence belongs in another paragraph.]

Is this sentence
strongly relevant to
the topic sentence?

Another approach
Yes

No

Setting balloons aloft [section heading]
Will other sub-topics
get in-depth
treatment?

Yes

You can set a balloon aloft by filling it with a gas that
is lighter than air. Two such gases can be readily
produced in the amateur chemist’s laboratory:
hydrogen and helium. [So far so good. The topic
sentence is relevant, and the second sentence is directly
elaborating on the topic sentence.]

Move it to another
paragraph

No

Is the sentence
crucial to the overall
discussion?

No

Yes

Add another
sentence to this
paragraph?

To fill a balloon with hydrogen gas … [The
relevance of this sentence to the topic sentence is rather
week. The topic sentence is about how to get balloons to
rise, but now we are talking about how to fill a balloon with
hydrogen. So this sentence needs to be moved to another
paragraph.]

Yes

No

Add another
paragraph?

To fill a balloon with helium gas …[The relevance
of this sentence to the topic sentence is rather week. The
topic sentence is about filling a balloon with hydrogen, but
now we are talking about how to fill a balloon with helium.
So this sentence needs to be moved to another paragraph.]

Yes

No

…
Finish

Good paragraphing: the
skimming test

Figure 1: Composing a paragraph

An example

The skimming test is based on the fact that most
people skim scientific and technical documents, only
reading the paragraphs that are of special interest to
them. Skimming is a two‐step process: read the first
sentence of a paragraph and then decide whether to
continue reading or skip to the next paragraph. More
often than not most readers will skip at least one
paragraph, and usually more. So, if you want to
maximise your chance of being fully understood by
the maximum number of people who look at your
document, make sure that:

Setting balloons aloft [section heading]
One way to set a balloon aloft is to fill it with
hydrogen gas. [Topic sentence: directly relevant to
heading? Yes. So leave the sentence where it is.]
There are a number of ways of generating
hydrogen gas. [Strongly relevant to topic? Yes. But this
sub‐topic is not going to get in‐depth treatment, and the
sentence is not crucial to the overall development of the
information. In other words, if skimmers miss this

2.1 ~ 2010
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Words



the main point of each paragraph is made in the
first sentence (so that the first sentence is the topic
sentence) and



all the first sentences, when considered together,
provide a satisfactory summary of what you have
written.

introducing one technique via a first sentence but not
the other will not pass the skimming test. For
example, the following list of first sentences would
not provide an adequate summary if a method of
filling a balloon with hydrogen gas was discussed in
addition to the method of filling a balloon with
helium gas:

So the skimming test is this: once you have
completed writing a section of your document, read
through it but just read the first sentence of each
paragraph. As you are reading, ask yourself:

You can set a balloon aloft by filling it with a gas that
is lighter than air.
To fill a balloon with helium gas …
You can track the balloon using a simple radio
transmitter.

Do all the first sentences, when taken together,
adequately portray the gist of the section of the
document I have just written? In other words,
would they, when strung together (and tweaked
with linking words), provide an adequate
summary of what I have written?

There are a number of ways you can improve your
chances of retrieving a spent balloon.

In this case, there needs to be a paragraph with a
sentence starting To fill a balloon with hydrogen gas …
or the like.

If the answer is no, then you should reconsider your
paragraphing.
For example, if you are presenting an argument
and it has four premises, it is unwise to present three
of the premises as first sentences and embed the other
premise within a paragraph (rather than at the start
of a paragraph). The skimming reader will not see the
full skeleton of your argument and may think that
you have not proved your point even if you in fact
have.

Note that while your set of first sentences should
provide an adequate summary of what you have
written, they may not necessarily provide a good
summary. There may be any number of paragraphs
that are providing merely secondary or illustrative
material—analogies, parallels, examples, case studies
and so on—paragraphs that could be deleted without
thereby breaking the basic logic of the text. A good
summary of that material would not include the gist
of the secondary or illustrative material.

Likewise, if you have been describing how to send
a balloon aloft by filling it with a gas that is lighter
than air and you have described in roughly equal depth
a number of techniques for producing such a gas,

However, the skimming test is designed only to
ensure that all the main points will be picked up by
the skimmer, not that the skimmer will only
encounter your main points.

First published in The Age, 31/10/2009. Reprinted with the kind permission of Michael Leunig. © Michael Leunig 2009.
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Paragraphing quotations
revisited

that it was the views of someone the author was
quoting. An example can be seen on page one of
Radical Hope by Noel Pearson.1

In a previous issue of Words (volume 1, issue 1), I
noted that a number of contemporary language
manuals are advising that quotation marks are not
needed around a block quotation, that is, a quotation
set apart and set differently from the text that
introduces it. A block quotation is often indented
from the left and often in a different font (or a smaller
font size) than body text. I went on to note that where
there are other types of content that you want to set
similarly (such as examples) it will help the reader
detect immediately that a block of text is a quote and
not something else if you enclose it in quotation
marks.

This problem can occur on other pages too, not
just the first page. For example, it will occur
whenever a block quotation of considerable size
starts at the top of any page. Without body text in the
immediate vicinity to provide a ready comparison,
the eye cannot easily detect the usually small
indentation (one or two em spaces, perhaps) and the
slightly smaller font size (usually just a point). Thus
it is all too easy for the reader to think, wrongly, that
what they are reading are the author’s views. It is
distracting for the reader to subsequently have to
disentangle the views of quoted sources from the
views of the author. An example can be seen on page
five of Radical Hope by Noel Pearson.2

But even if there are no other content types that
you want to set in a similar way to block quotations,
there are still good reasons for setting block
quotations in quotation marks. For example, suppose
you start a document with a quotation. If the
quotation takes up most or all of the first page of the
document, the reader will have no obvious clues
right away that what they are reading is a quotation.
They might only find this out after turning the page.
Thus they start out thinking that what they are
reading are the author’s views only to discover later

Journal

It is best, then, to continue using quotation marks
for block quotations (just as they are used for direct
quotations in running text).
Geoffrey Marnell

1.
2.

Quarterly Essay 35, Black Inc., 2009.
ibid.
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Looking at DITA as just another tool
Don't start at the beginning

Suchitra Govindarajan
I’m not an expert on DITA, but I consider myself
well‐qualified to write about learning it. Over the
past few years, Iʹve made a number of attempts to
learn DITA, both on my own, and with some help. A
complete grasp of the subject eluded me until I did a
course on structured authoring with DITA at
Swinburne University.

Nearly every DITA tutorial begins with a definition
of DITA and a rundown of XML and document type
definitions (DTDs). My view on this is similar to my
view on prologues in fiction: they make more sense
after you’ve read the book.
Don’t worry about what DITA is. It is indeed an
XML architecture and a writing methodology. It
might even be a new paradigm. However, these
definitions do not really help someone who is
attempting to learn DITA. You also don’t need to
know anything about DTDs or XML schemas,
beyond the fact that DITA, by definition, comes with
a set of these.

My eureka moment came early in the course. In
the space of about 30 minutes, all of us students were
able to author simple topics in an XML editor and see
them transformed into CHM and PDF files. I thought
to myself, is DITA really this easy?
I kept going back to that question during the
course, and, every time, the answer was different.
There are aspects of DITA that are impossibly
complex: publishing to a well‐styled and readable
output, for one. There are also parts of DITA that are
very simple—even for the most non‐technical of us. If
you choose an XML editor with a What‐You‐See‐Is‐
One‐Option (WYSIOO) view (explained in the next
section), it’s really not that different from learning
any other authoring tool. And, as with any other
authoring tool, you can jump right in without
knowing anything more than just the basics.

In order to write in DITA, all you really need to
know is the following.


You mark up text using elements and attributes.
If you’re familiar with HTML, you already know
what elements and attributes are. At its simplest,
an element is a container for text. An attribute is a
descriptor for that container. The rules for
elements and attributes in XML are different
from those in HTML and are generally stricter.



You don’t get to choose styles. When you author
in DITA, you have no control over style
information such as fonts and colours. Most XML
editors will choose a pretty, formatted look on
your behalf. This is called a WYSIOO view. It is
not part of your file. It is just a mock‐up of how
your file could look when published. You’ll only
see that view while you’re in the editor.



You need to check if your document is valid.
Working with DITA means that you’re
conforming to a standard. Therefore you need to
validate every document you author against the
standard. Thankfully, most XML editors will
either not allow you to create invalid documents,
or will alert you when your document is invalid.

This article is my rough guide for those who
would like to jump right in. (Note that we won’t
cover publishing or anything to do with the DITA
Open Toolkit.)

MACQUARIE
DICTIONARY
ONLINE
www.macquariedictionary.com.au

What you already know about
DITA

Subscribe to the complete Macquarie Dictionary online,
updated annually with new words and deﬁnitions.

A lot of the ideas behind DITA are not new. If you
have had a few years experience as a technical writer
and have used at least one help‐authoring tool,
there’s a lot you already know. For example:

Also available online is the full Macquarie Thesaurus - that
perfect word is just a click away.
Try it out now for FREE!
Macquarie Online is offering free extended trial access. Simply
contact Macquarie Online to set up your 3 months free access.
Quote code: 3mfTrialAC



Macquarie Online Support
phone: 1800 645 349
email: support@macquarieonline.com.au

Topic‐based authoring will be familiar to anyone
who has used a help‐authoring tool such as
Adobe RoboHelp or Madcap Flare. You would
also be familiar with the idea if you’ve published
a long document in HTML format. DITA takes a
more narrow view of what a topic is than most
other tools. We’ll cover that in the next section.

!USTRALIASåNATIONALåDICTIONARY
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Single‐sourcing has been discussed for many
years in the technical writing industry: from one
set of files you can create various outputs.



DITA maps are not dissimilar to tables of
contents in help‐authoring tools or books in
Adobe FrameMaker.



Content reuse is familiar to anyone who has used
Adobe FrameMaker’s text insets or Madcap
Flare’s snippets.



reference topic accordingly. Each topic type provides
different elements and only those are allowed within
it. In other words, you cannot mix two content types
in the one topic, such as a concept followed by a task.
You need to create separate topics, one for each
content type.

Start writing
The two main features you should look for when
choosing an XML editor are a WYSIOO view and
built‐in support for DITA. My recommendations are
XMLmind (http://www.xmlmind.com/xmleditor/) or
XMetal (http://na.justsystems.com/index.php).

Separation of content and style is not new to
most writers either, even if we have never
encountered such a clear and total separation.
Many of us have authored raw text in HTML
with the styling provided by a separate CSS.
Those who have published in different formats
will also have experienced authoring in one view
and publishing to another.

Support for DITA usually means that you can
simply go to the File menu, choose New and select
from a list of DITA topic types (concept, task and
reference). You’ll also find software aids that list the
elements that are allowed at various positions in the
document. For example, in XMLmind, you can use
the Insert, Insert before and Insert after options to
determine what elements are allowed on either side
of the current one (see Figure 1 below). You can also
access all allowed attributes and values.

Know what you want to write
about
To get the most out of your learning experience, I
would recommend that you select a fairly complex
practice project, one that includes everything you
would find in a common document—images, cross‐
references, links and so on.

In XMLmind, you can also press SHIFT + F1 at any
time to look up the DITA content model. The content
model is a bit technical but, once you learn to parse it,
you will find useful information about DITA.

The biggest difference I found with DITA was that
I had to select the kind of topic I was going to write
before I started to write it. Changing my mind
afterwards was possible, but a bit complicated.

Write as you would normally, selecting the right
elements and attributes for your needs at every stage.
I like switching to other views— such as the structure
or code view—to see the effect of additions and
changes. Remember to validate your document
frequently.

DITA requires you to choose up‐front whether
you’re going to write conceptual material (such as an
overview), a task (such as a procedure) or reference
information (such as information that would
normally be in an appendix). Having made that
choice, you then choose a concept topic, task topic or

When you have created a few topics, you can also
look at creating DITA maps and publishing them.

Figure 1: Using XMLmind's DITA aids

2.1 ~ 2010
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Help with writing

Cut to the present world of instant blogs and
websites, where you don’t even need to know that
you’re using HTML.

If you find writing in DITA difficult, consider looking
at sample DITA files. There are some available at
http://dita‐ot.sourceforge.net/SourceForgeFiles/doc/
user_guide.html.

On one hand, I am excited by DITA, by its sheer
elegance. On the other hand, when I read some of the
DITA documentation, I feel like I’m about to drown
in jargon. I look forward to the time when we’re all
authoring in and publishing from DITA, but have the
ability to choose how deep our knowledge should go.
Just as it is now with HTML.

Better still, follow the tutorial that is part of the
excellent DITA for Solo Writers guide at http://
www.ditausers.org/tutorials/lone‐dita/ditaguide.pdf
(especially the “Creating Content” section).

Conclusion
Suchitra Govindarajan

In the early days of the internet, it was a matter of
pride to have coded your website solely in Notepad.
People who used software like Microsoft FrontPage
were looked down upon.

Suchitra Govindarajan has been a technical writer since
2000, and has worked in India and Australia. She hates
misplaced modifiers and anything made with eggplant.

Book review
Nikki Ward

As a whole, the text promotes a strong awareness
of language origin, spread, endangerment and death,
with a vast array of solid examples to back up the
assertions made. The most striking aspect of this
work is how Evans demonstrates language at work
within culture as an expression of our thoughts and
hence our reality. He expands on William von
Humboldt’s (1767–1835) theory that one can only
develop a “comprehensive recognition of an
objective world” through the combination of all
languages used to describe the world. No one

Dying Words: Endangered languages and what they
have to tell us by Nicholas Evans (John Wiley & Sons,
Richmond, 2009, $49.95)

When I first heard about this book many questions
surfaced: “Why on earth do we have to be concerned
about language death? What is it that different
languages brings us in terms of a collective human
legacy? Why does it matter? Or does it matter at all?”
Then you read descriptions of this book that go along
the lines of:
“The next century will see more than half of the
world’s 6,000 languages become extinct, and most
of these will disappear without being adequately
recorded. Written by one of the leading figures in
language documentation, this fascinating book
explores what humanity stands to lose as a result.”1

Being a multilinguist myself, and a speaker of a
dying language (Afrikaans), I felt a certain
fascination in finding out what Professor Nicholas
Evans had to say about the importance of language
preservation. My first impression from the book
reviews was that this would be an easy read,
especially since I was already keen to consume its
contents. However, when I received the book I could
see that this was, in fact, a very detailed academic
work. That said, it is written simply enough for the
layman to understand, and I found that I was
enchanted by the substance of its content. In places,
and I hasten to add only in places, did I find the text
became a little too complex (in terms of linguistics
theory).

1.

Words

Reiter’s Scientific, Professional Technical Books,
http://www.reiters.com/, Viewed 3 January 2010.
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language alone can give you this. Evans posits that
language exposes new modes of thought, giving us a
“new lens” to perceive the world through. He
theorises that language and thought act in tandem to
create our reality, through a thought process known
as convergence and another phenomenon known as
linguistic relativity.1 Given that our thoughts and
hence our language create our reality, Professor
Evans states:

can be traced to a conversation between a Samoan
translator (a missionary’s son), a Samoan tribal healer
and an ethno‐botanist. Without access to the
language, that knowledge may have stayed buried
for a while longer, and how many lives would have
been lost as a result?

With reference to the hidden knowledge that
language carries, Evans shows how words are used
in indigenous languages to describe ecological links
between plant and animal species that in turn made
the transmission of empirical knowledge easier and
more accurate. My favourite example is where the
discovery of Prostarin, effective against HIV‐type 1,

improvement sat. This process is extremely
subjective and exposes how different words were
supplanted to correlate with what the destination of
the translation is for, namely, a particular religion.
The translation did not adhere to the actual textual
meaning but rather to what people wanted it to say.
For example, one translation states:

It’s not all bad though. Language death does have
an upside. Interestingly enough, language death can
also give rise to language birth (or rebirth to be more
“… there may well exist a completely different but
accurate). Scripts and texts that have been buried for
internally coherent model of the physical universe,
centuries are rediscovered and then reconstructed to
right down to the base ontologies of space and time.”
give historians an inside picture on what life was like
(p. 162)
at that time, and for linguists, an idea on how the
language of that time functioned grammatically.
I found myself deep in contemplation after
Here Evans looks at how written records can
reading this particular chapter. I realised that each
experience multiple deaths due to physical
language—with its unique philosophy, knowledge
destruction, misplacement or decay—or, in some
and cultural assumptions—gives us access to new
cases, overwriting, thus giving rise to palimpsests. I
doors of perception (so it seems that Aldous Huxley
had to look this word up, but basically it is a medium
was onto something, although I hasten to add, my
for writing—such as a parchment—from which the
epiphany wasn’t drug‐induced!)
writing has been partially or
Evans goes on to state that
completely erased to make room
languages, as phenomena,
for another text. (In other words,
To capture languages allows us to preserve
have a direct impact on our
manuscripts were reused
modes of thought that we could not
collected intellectual heritage.
several times, mostly due to
otherwise access with just one language.
Further, he attributes the
resource shortages.) In early
demise of indigenous
Christian times, a single folio of
linguistic diversity to European colonisation and to
parchment—a sheet folded so as to yield four
the elites in the nation‐states they created. For
pages—required the skin of an entire sheep. To create
example, much colonisation was carried out by
a book similar to the one I am reviewing would have
countries steeped in the Judeo‐Christian tradition, a
required the slaughter of around 90 sheep!
tradition that attributes the profusion of languages to
The process of language reconstruction is not a
God’s wrath at man’s attempt to build a tower that
simple
one and at best, unwieldy. Evans outlines a
would reach to Heaven (the Tower of Babel). Such a
six‐step
plan that allows linguists to reconstruct
belief, Evans contends, was the basis for colonists to
undeciphered
scripts. However, the resurrected
actively discourage the speaking of indigenous
language
and
culture
is impoverished because the
languages. From the indigenous perspective,
reconstruction
lacks
the
richness of its original form,
however, linguistic diversity was akin to a passport
much
like
the
reconstruction
of a digital wave form
allowing its speaker to hold identity and to make
from
an
analog
wave
form.
claim to country. It vested them with authority and
spiritual security and gave them access to hidden
Evans also looks at the touchy subject of biblical
knowledge. Sadly this aspect of our collected cultural
text translation. This is where I tried my own hand at
heritage has been severely impoverished as a result
looking that the metadata of a direct translation that
of cultural genocide, but that said, it is evident that
was used for a number of other biblical translations
people like Evans are doing some good work in this
(for example, the English King James translation, and
area by documenting languages on the endangered
the Good News for Modern Man translation). I could
list.
see where the margin for error and the room for

1.

“… in perils of robbers, in perils by mine own
countrymen, in perils by the heathen …”

See BL Whorf, Language, thought and reality, MIT Press,
Cambridge MA, 1956.
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But this appears in the Good News for Modern Man
as:

tremendous double‐vision when it comes to placing
cultures side‐by‐side. This is where the juice is: it
allows for creative thinking, and, as Einstein once
said, “the secret to creativity is knowing how to hide
your sources”.

“… in danger from fellow Jews and from Gentiles
…”1

As subtle as this may seem, this blatant word
replacement makes all sorts of assumptions about
what was originally intended. Draw your own
conclusions!

Double‐vision aside, why would I want to
preserve Afrikaans? Well, because there is an
inherent beauty and comedy in Afrikaans expression
that I just love. Sadly, this gets lost in translation into
English, so there is no point in trying to explain the
following example. But for those who understand
Afrikaans, I read recently about two game rangers
who were chased by a lioness while riding motor‐
bikes around the Kruger National Park. One ranger
describes it as follows: “… nadat die lieeu vyfie moeg
raak om agter ons te hol, het ons motorfietse eindelik
tot rus gekom. Toe ons van ons motorfietse afklim het
ons kneie skoon inmekaar geswak.” Basically, their
knees wouldn’t function (they sagged) when they got
off their bikes as a result of being chased by the lion,
but it is so much funnier in Afrikaans.

In closing, Evans agrees with Tomasello that:
“… new forms of cultural learning create the
possibility of a kind of ratchet effect in which
human beings not only pooled their cognitive
resources contemporaneously, but they also built on
another’s cognitive inventions over time. This new
form of cultural evolution thus created artifacts and
social practices with a history, so that each new
generation of children grew up in something like
the accumulated wisdom of their entire social
group, past and present.”2

In my opinion this is the crux of the book: what
legacy are we offering to humanity? To capture
languages allows us to preserve modes of thought
that we could not otherwise access with just one
language. Without language diversity we rot in
stagnant waters and place our species in danger of
group‐think, where only one mode of thought
transports us to the he‐with‐a‐hammer‐thinks‐
everything‐is‐a‐nail territory. I for one, see Afrikaans
as a dying language in South Africa. Sadly, I don’t
speak it much in Australia, yet it gives me

1.
2.

Dying Words has been a tremendously worthwhile
read and it took me on quite a journey, both
geographically and mentally. For anyone interested
in linguistics or simply fascinated by how languages
work—from borrowed words to language evolution
to the preservation of language—the value of the
content of this book far outweighs its cover price.
Nikki Ward
Nikki Ward works as an IT documentation and training
analyst creating training programmes, e‐learning
resources and user guides. She also has an associate degree
in writing and is passionate about languages of any
description, from Auslan (sign language) to Hebrew. She
can be contacted at ezistep@gmail.com.

2 Corinthians 11: 26–7.
M Tomasello, The cultural origins of human cognition,
Cambridge University Press, Cambridge, 1999, p. 527.

Don’t miss this great professional development and networking opportunity!

AODC 2010

12th to 14th May 2010
Darwin, NT, Australia

Darwin, Australia – 12th to 14th May

20 Sessions... 10 Expert Speakers... Pre-Conference Workshops... Social Events... Networking...
Knowledge Management, DITA, eLearning, Help, Structured Documents, Wikis, Case Studies, more...
Keep your skills up-to-date, and learn new techniques, tips and
technologies. If you missed a previous AODC, don’t make the
same mistake in 2010!

Register now at www.aodc.com.au

Words

19

The biggest annual event for technical
communicators from Australia and New Zealand

Proudly presented by

2.1 ~ 2010

Miscellany
Poetry and technical writing: an odd couple?

Greek)? Are there no sentences in Sanskrit, or is every
self‐contained text one entire sentence?

Back in the 1980s and early 1990s, a number of
academic papers were published linking poetry and
technical writing. No laughing: it’s true. There were
claims that both disciplines used similar language
structures and communicative techniques, and that
academic studies in poetry provided a good basis for
teaching technical writing.1 I’m sure that there are
some contemporary technical writers who would be
disappointed to learn that that thread of academic
enquiry died out fairly quickly. An Ode to Microsoft
Word just wouldn’t cut it with today’s economic
rationalists, with their graceless utilitarian
imperatives. And perhaps not with readers, too.

On the other hand, if a sentence is defined,
somewhat more intuitively, as the container for a
discrete chunk of independent information3, then
much of what we commonly write and think of as a
sentence is not a sentence at all. Consider, for
example, The pound is rising and the dollar is falling.
This has all the appearances of a single sentence, but
it contains two chunks of information, each in a
separate clause and each capable of being expressed
independently.
So, as for the verbal runniness of Hugo, Joyce and
Coe, they either wrote strings of words that were not
sentences—concatenating clauses into something
part‐way between a sentence and a paragraph—or
they need to give up their titles as Kings of Verbosity
to the writers of Sanskrit and Ancient Greek. Or
maybe our definitions of sentence need tightening.

But that doesn’t mean, of course, that one can’t
wax lyrical about technical writing itself, even if it
would, on reflection, be rather silly to wax lyrical
about a steam iron or bookkeeping software. Indeed,
there are many technical writers passionate about
poetry, and some have even had poems published.
That obviously puts paid to the belief that a career
that calls for simple, plain, utilitarian English day in
day out invariably blunts one’s vocabulary and saps
one’s creative juices.

Emetic writing
“Reporting to the director, the role facilitates the
work of the HR functions, continuously improves
strategies and procedures, while interfacing the
internal and external environments.”

So here’s a call to all poets and would‐be poets,
those who sublimate their verbal creativity in the
quotidian mundaneness of technical writing. The
next issue of Words will have a poetry section, and the
editorial team invites you to submit a poem related,
in some degree or other, to technical writing. The
deadline is 30 March, and only one potential
contributor is blacklisted: Anonymous. Send your
contributions to words@abelard.com.au.

Yuk. This is from an advertisement for a “Manager –
Administration” at Monash University, one of many
examples of gut‐turning managerial speak quoted in
Don Watson’s new book Bendable Learnings4. Watson
is an indefatigable critic of the puffery and
obfuscation of the language of governments,
bureaucrats and managers. His new book is a
collection of many hundreds of examples of such
language. Here is another:

But what is a sentence?

“Ford in Australia will right‐size our business by
staff‐balancing changes …”5

In 1975, Timothy Fullerton published Triviata: A
Compendium of Useless Information in which he
claimed that an 823‐word sentence in Victor Hugo’s
Les Miserables is the longest sentence ever published.
Since then, numerous longer sentences have been
uncovered. For example, there is a sentence of 4 491
words in James Joyce’s Ulysses. And a 2001 novel by
Jonathan Coe—The rotters club—sports a 13 955‐word
sentence. Impenetrable stuff, indeed.

Yep, we’re going to sack some staff, but, boy, we’re
not going to make it that damn obvious.
Watson’s collection is both side‐splitting and
frightening, and no one should be distracted from the
message by the sloppy editing of Watson’s own
words, editing that missed a clanger like this:
“It is the principle task of the manager … to limit
the expression and consequences of this …”6

But hang on a tick. How have the sentences in the
works of these long‐winded word‐sadists been
identified? By the appearance of a concluding full
stop, it seems.

Vale
Vale Naomi Hall: 1972–2009. Technical writer and
special friend to many.

But if a sentence is simply a string of words
marked out with special punctuation—such as a full
stop2—then what of those languages that don’t use
any punctuation (such as Sanskrit and Ancient

2.
3.
4.

1.

See, for example, John S. Harris, “Poetry and technical
writing” in Journal of technical writing and communication, vol.
23, no. 4, 1993, pp. 313–31.
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5.
6.
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See Style manual for authors, editors and printers, John Wiley,
2002, p. 97.
www.macquariedictionary.com.au (Macquarie Dictionary
Online). Viewed 18 September 2009.
D Watson, Bendable learnings: The wisdom of modern management,
Knoff, North Sydney, 2009, p. 87f.
ibid., p. 91f.
ibid., p. 10.
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Mindstretchers
Geoffrey Marnell

can omit both b and c. Consider, then, the following
exhaustive combination of results in which neither b
nor c occur:

Devilish sequences

3a + 2d + e + f
3a + d + 2e + f
3a + d + e + 2f

What number comes next in the following sequence?
1

4

9

16

?

And what about this one?
3

–112

69

1003

–47

In all cases, Allan would have beaten Bertram
more times than Bertram would have beaten Allan,
and Bertram would have beaten Craig more times
than Craig would have beaten Bertram. So the major
condition set in the puzzle is met. But in addition,
each combination gives Craig 4 victories over Allan
which, given the fact that Allan beat Craig at least 3
times out of 7 races, is the maximum possible number
of times Craig could have beaten Allan. QED.

?

These are strange times indeed!
A woman born in 1896 has had just five birthdays by
1 April 1920. How is that so?
Solutions will appear in the next issue of Words.

Solutions to the last puzzles

Puzzle 2

Puzzle 1

You may have guessed, given the vast number of
possible arrangements of the slips of paper, that there
must be a short cut to answering this puzzle. And
there is. A little experimentation will show that a
number is divisible by 3 if the sum of its individual
digits is divisible by 3. Consequently, the order in
which the slips of paper are drawn out of the bowl is
unimportant. For the sum of the digits in the
numbers 1 to 20 (which, incidentally, is not the same
thing as the sum of the numbers from 1 to 20) is 102.
And since 102 is divisible by 3, any number
composed—in any order whatsoever—of the 31
digits that make up the numbers from 1 to 20 must
itself be divisible by 3. So the probability that the 31‐
digit number formed is divisible by 3 is 1: a dead
certainty. QED.

Consistent with the clues given in the puzzle is the
possibility that Craig beat Allan 4 times. This seems,
at first, paradoxical, since Craig would then have
beaten Allan more times than Allan would have
beaten Craig despite the fact that Allan beat Bertram
more times than Bertram beat Allan, and Bertram
beat Craig more times than Craig beat Bertram. But
here’s proof that it is possible.
Letting A stand for Allan, B for Bertram and C for
Craig, the following table represents the 6 possible
ways the three could be placed in a race:

a
b
c
d
e
f

1st

2nd

3rd

A
A
B
B
C
C

B
C
A
C
A
B

C
B
C
A
B
A

We are told that possibility a occurred 3 times,
and since it was the most consistent result, no other
result occurred 3 or more times. This leaves us with
35 combinations of these possibilities representing
exactly 7 results (e.g. 3a, b, c, d and e; 3a, 2b, c and d;
and so on). Rather than working through each of
these combinations and noting, for each, the number
of instances where Craig has come home before
Allan—a long and tedious process—you can employ
a little logic to make life easier. You will note that
each of possibilities a, b and c has Allan beating
Craig, while each of possibilities d, e and f has Craig
beating Allan. We need only consider, then,
combinations of these possibilities where members of
the latter set (d, e and f) appear more frequently than
members of the former set. We cannot, of course,
omit a (which occurred in 3 of the 7 results), but we
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